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Institutes

OpenAlea is developped by 3 institutes : CIRAD, inria and INRAE.



License

OpenAlea is licenced under the CeCILL-C free software license agreement.



Official documentation

https://readthedocs.org/projects/openalea.readthedocs.io


Description

OpenAlea is an open source project primarily aimed at the plant research community. It is a distributed collaborative effort to develop Python libraries and tools that address the needs of current and future works in Plant Architecture modeling. OpenAlea includes modules to analyse, visualize and model the functioning and growth of plant architecture.

This repository contains all the documentation publish in the official documentation of OpenAlea [https://readthedocs.org/projects/openalea.readthedocs.io/en/latest].

Information about OpenAlea can also be found in the wiki: https://github.com/openalea/openalea.rtfd.io/wiki



Installation

You will need conda to install OpenAlea. Instruction for installing it can be found in the miniconda website [https://conda.io/miniconda.html].

Then you will need a consoelor a terminal to install the packages you want to use

conda create -n openalea -c openalea3 -c conda-forge openalea.[package_name]







Usage

Tutorials to use the differents features of OpenAlea can be found in the documentation [https://openalea.readthedocs.io/en/latest/tutorials/index.html].



Sposors



Contribution

You can contribute to the OpenAlea project by participating in the Git Workflow [http://virtualplants.github.io/contribute/devel/git-workflow.html], or by opening an issue or a pull request to adress a problem or a fix.
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Quick Start

You can find here basic guides and procedures for using OpenAlea
with instructions on how to develop your own package.


Installation

For general information about installation, please read
Installation Guide [https://openalea.readthedocs.io/en/latest/install.html].

If you are looking for a specific package installation, refer to the package
documentation in Packages [https://openalea.readthedocs.io/en/latest/packages/index.html].



Tutorials and Gallery

You can find examples of what can be done with OpenAlea,
you can check the Tutorials [https://openalea.readthedocs.io/en/latest/tutorials/index.html]
and Gallery [https://openalea.readthedocs.io/en/latest/tutorials/index.html#gallery] pages.



Packages

Packages page [https://openalea.readthedocs.io/en/latest/packages/index.html] also contains
brief presentations of official and available packages.



Development

If you want to contribute to the project, you are welcome.
See the Development [https://openalea.readthedocs.io/en/latest/development/index.html] page
for more information.





          

      

      

    

  

    
      
          
            
  
User Guide

Models under OpenAlea are in the form of components that could be used as such,
or combined together to build user-customised applications. OpenAlea provides two
different ways to interacts with components:


	by visual programming, using Visualea


	by writing scripts, using a standard python development environment




Both methods allows you to save your application and run it routinely in batch mode.
Visual programming is easier to start with, and it allows you to rapidly discover
components of a package. Python scripting allows for programming more complex tasks,
and provides an access to additional functionalities of models, by importing python
modules that compose them.


Visual Programming

OpenAlea provides an high level visual programming interface Visualea.

The main documentation is on
Packages [https://openalea.readthedocs.io/en/latest/packages/index.html] at Visualea.

Tutorials have been made on Visualea. You can find them on
Tutorials [https://openalea.readthedocs.io/en/latest/tutorials/index.html].



Python Scripting

OpenAlea packages are available under the python scripting language. This allows to use the
components of packages (as in visualea), but also to directly import python modules and get
access to all functionalities documented in package’s API.


Using Python

Python is a scripting language widely spread in the scientific community.
It has a lot of advantages :


	It is easy to learn, even for non programmers.


	It is an high level language, based on the object paradigm


	It is extensible with external libraries


	Multi-platform (Linux, Windows, Mac)




You can learn the basics with the Official Tutorial [http://docs.python.org/tut/]

Python scripts could be launched by invoking python from a command line:

python myScript.py





You can also launch a Python interpreter and run or test your script step by step.

The default interpreter could be launch by typing python in a terminal (Linux, Mac) or
in a DOS windows. Under Windows, you may also use one of the following method:


	Use Start Menu -> openalea -> python shell


	You can use the default python interpreter GUI : IDLE (start menu -> Python 2.4 -> IDLE)




You can also use more ergonomic user interface, like ipython, that provides usefull
functionalities (completion, coloration, execution of block of lines,…)



Importing OpenAlea Modules

The magic line which will make available all openalea modules is:

import openalea





All OpenAlea modules are available in the openalea namespace. Refer to the modules documentation
to learn how to use them.

You can also write simple python scripts in order to execute the same code several times.






          

      

      

    

  

    
      
          
            
  
Installation


Conda Installation

Conda [https://conda.io] is a package manager that can be installed on Linux, Windows, and Mac.
If you have not yet installed conda on your computer, follow these instructions : Conda Installation [https://conda.io/miniconda.html].



OpenAlea Installation

The recommended way to install OpenAlea is to create a new conda environment.

First, create an environment named openalea:

Launch a console or a terminal (See Anaconda Prompt in Start menu on windows).
In this console, to install a given openalea package <package_name> with its dependencies, execute this:

conda create -n openalea -c openalea3 -c conda-forge openalea.<*package_name*>





Here is an example if you want only PlantGL, lpy, MTG and Caribu:

conda create -n openalea -c openalea3 -c conda-forge openalea.plantgl openalea.lpy openalea.mtg alinea.caribu





Activate the openalea environment:

conda activate openalea





In this environment, you may also want to install other Scientific Python packages:

conda install notebook matplotlib pandas





In the documentation of each package, a installation procedure is described.





          

      

      

    

  

    
      
          
            
  
Application Domains




          

      

      

    

  

    
      
          
            
  
Tutorials

Here are some interactive tutorials that can help you in your projects.



	Using Visualea : Beginning
	The Goal

	Step 1 : Create Your Own Package

	Step 2 : Read CSV Data

	Step 3 : Create a simple 3D representation of one tree

	Step 4 : Create a Macro Node / Group Nodes

	Step 5 : Get the spatial distribution of the trees

	Step 6 : Apply the process to multiple trees





	Using Visualea : Weberpenn
	Context

	Install

	Model Parameters

	Begin with weberpenn











Gallery


[image: ../_images/plantgl_objects.png]
 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/plantgl_objects.ipynb]
3D Geometric Modelling and Visualisation




[image: ../_images/mtg_plantframe2.png]
 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/mtg_plantframe.ipynb]
3D Reconstruction of Plant Architecture




[image: ../_images/lpy_lpymagic1.png]
 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/lpy_lpymagic.ipynb]
L-Systems Simulation




[image: ../_images/hydroshoot_grapevine2.png]
 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/hydroshoot_grapevine.ipynb]
Reconstruction and Ecophysiology of Grapevine




[image: ../_images/caribu_crops.png]
 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/caribu_crops.ipynb]
Light Interception




[image: ../_images/strawberry1.png]
 [https://nbviewer.org/github/openalea/strawberry/blob/master/example/application/Strawberry_Application_demonstration.ipynb]
Strawberry architectural analysis construction & vizualisation of 2D/3D architecture.






          

      

      

    

  

    
      
          
            
  
Using Visualea : Beginning

Here is a tutorial in which you will see how to implement a simple modeling problem in Visualea

[image: ../../_images/intro.gif]
Here is what you need for the following tutorial

conda create -n visualea_tuto -c openalea openalea.visualea openalea.components openalea.plantgl boost=1.66 -c openalea/label/unstable
conda activate visualea_tuto





Once you installed and activated the OpenAlea environment (see Installation [https://openaleadocs.readthedocs.io/en/latest/install.html]), execute this

visualea






The Goal

We measured some tree data and saved these in a tabbed editor (like Excel). The data has been exported in a CSV file. We want to have a simple 3D representation  of the measured tree.

Here is the data :










	X

	Y

	crown_up

	crown_bot

	trunk_diameter





	0

	0

	10

	20

	2



	10

	12

	12

	18

	3



	20

	22

	8

	23

	3.4



	0

	18

	14

	22

	2.5






You may want to download the CSV file [http://openalea.gforge.inria.fr/dokuwiki/lib/exe/fetch.php?media=documentation:tutorials:stand.csv].



Step 1 : Create Your Own Package

First of all, we need to create a package where to put your work (dataflow, node definition, data, …). A package is in fact a simple directory containing python files.


Create a package


	Select Package Manager -> Add -> Package


	Fill the form :


	Name : standbuilder


	Description : build stand representation from measured data


	Version : 0.1


	License : Cecill-C


	Authors : All collaborators and package writer


	Institutes : …


	URL : …


	Path : /home/myhome/openalea_pkg (could be anywhere you want)






	Click “OK”




[image: ../../_images/step1.gif]
Your new package should appear in the package manager.


Tip

The path corresponds to the directory where the python file will be written.
Choose it carefully in order to be able to find it later.






Step 2 : Read CSV Data


Create a dataflow to read and view a file


Tip

Leaving the cursor on any item in the Package Manager, or on nodes or ports in
the dataflow view brings up a tooltip. Clicking on them also shows some documentation
in the “Help” tab (bottom-left-hand corner).




	In the Package Manager tab (left column), open the openalea.file folder. You should
see a list of nodes.


Note

You can search for a particuliar node in the Search tab.





	In the Package Manager tab, drag the read node from the openalea.file package to the
workshop. It should now appear on the canvas.


	In the workspace, right click on the read node and choose “Open Widget”.
Then browse for the “stand.csv” file (no need to validate anything,
changes are automatically taken into account so you can simply close the window).


	Drag the text node from the openalea.data structure.string folder onto the workspace.


	Connect the output of the read node to the input of the text node.




[image: ../../_images/step2.1.gif]


View the file contents


	Right click on the text node and select “Run”


	Right click on the text node and select “Open Widget”






Build a CSV object

In order to manipulate the CSV data, we are going to build a CSV object.


	Select the search tab in the package manager


	Type CSV


	Drag the read csv node on the workspace


	Do the same to create a getitem node (openalea.python method.getitem)


	Connect read’s output to read csv’s input


	Connect read csv’s first output to getitem’s first input


	Add an int node on the workspace, and connect its output to the second input of getitem


	Execute the graph by selecting “Run” in the context menu of the getitem node


	Print the output in the shell : Right click on the output port, and select “Print”




[image: ../../_images/step2.2.gif]


Save your work


	Select File -> Save as composite node (CTRL + S)


	In the selector dialog, click “New” Button


	In the new dialog


	Select the standbuilder package in the combo box


	Enter the name : readcsv_1


	Add a description : Read data file


	Click “Ok”






	In the selector, click “Ok” button


	The new graph should appear in the standbuilder package.




[image: ../../_images/step2.3.gif]



Step 3 : Create a simple 3D representation of one tree

Before displaying the whole stand, we must rebuild a tree.
In this tutorial we build a very simple tree representation composed by a
sphere for the crown and a cylinder for the trunk.


Create a 3D object

This simple dataflow shows how to display a scene object.


	First step, we create a new workspace : Select File -> New Empty Workspace (CTRL+T)


	Create the following dataflow by using PlantGL nodes


	vplants.plantgl.objects.cylinder creates a cylinder


	vplants.plantgl.objects.translated moves the input object


	openalea.data structure.tuple.tuple3 to set the translation vector


	vplants.plantgl.visualization.plot3d to view the result


	openalea.data structure.float to set the parameters of the tuple3 node








[image: ../../_images/step3.1.PNG]


Create a simple tree

To build our tree, we must construct a PlantGL scene containing a cylinder and a sphere.


	Modify the previous dataflow as follow:


	Add a vplants.plantgl.objects.sphere object


	Add a vplants.plantgl.objects.translated object


	Add a vplants.plantgl.objects.scene object


	Connect the 2 translated objects to a vplants.plantgl.objects.scene object






	Save this dataflow in your standbuilder package as simple_tree




[image: ../../_images/step3.2.PNG]



Step 4 : Create a Macro Node / Group Nodes

We will need to use the previous dataflow to build trees.
To simplify this procedure, we would like to use a simple node and not a complex dataflow.
For that we are going to embed the previous dataflow in a composite node (also named macro node).


Transform simple_tree to a reusable composite node


	Select simple_tree in the package manager


	Right click on the simple_tree graph, select “Properties” and click on the “Inputs / Outputs”
button


	Add 5 inputs with the + button :


	X - IInt - 0 - X position


	Y - IInt - 0 - Y position


	crown_up - IFloat - 16.0 - Top of the crown


	crown_bot - IFloat - 8.0 - Bottom of the crown


	trunk_dia - IFloat - 3.0 - Trunk diameter






	Add 1 output with the + button


	scene - None - PlanGL scene




[image: ../../_images/step4.1.PNG]


	Click “OK” and the buttons will appear in the workshop


	Modify the graph as follow


	Connect input 0 and 1 to the X and Y nodes


	Connect input 2 and 3 to a minus node openalea.math.-, and connect the result
to the crown radius


	Connect input 5 to the trunk radius


	Connect input 3 to the crown bottom






	Save your work as a new composite node in standbuilder named tree_scene




[image: ../../_images/step4.2.PNG]


Using the new composite node in a dataflow


	Open our first dataflow readcsv_1 in the standbuilder package (doubleclick)


	Drag the node standbuilder.tree_scene on the new workspace


	Add 5x getitem and 5x string object


	Connect the nodes as the picture in order to retrieve to different object properties


	Add a plangl.visualization.plot3D object and connect it to the output of tree_scene


	Run the dataflow several times and change the value of the first getitem (object index)


	Save the dataflow in the standbuilder package as readcsv_2






Create a composite node by grouping nodes


	Select the 5 getitem and their associated string object


	Click on Menu Workspace -> group (CTRL+G)


	Run the dataflow


	Save it in the standbuilder package as readcsv_3




[image: ../../_images/step4.3.PNG]
[image: ../../_images/step4.4.PNG]



Step 5 : Get the spatial distribution of the trees

We want to extract from the csv object the X and Y properties and plot them in 2D.


Extract data


	Create a new workspace (CTRL+T)


	Add a read node and a read csv node to read a csv file


	Set the file to read by opening the read widget (Open Widget)


	Run and display the output (output port context menu -> Print or Tooltip) : it’s a list of obj


	Add a getitem node and an int node to select an object in the list


	Add an extract node and 2 string nodes to select properties in a particular object


	Set the 2 string objects to X and Y


	Run and display the output (output port context menu -> print or tooltip) : it’s a
list containing the X and the Y properties of the selected object.




[image: ../../_images/step5.1.PNG]


Implement iterative process

We want to do the same thing, but for all the CSV objects contained in the file.


	Remove the getitem and the int nodes (with suppr)


	Add an openalea.function operator.map


	Connect the output of extract to the first input of map


	Connect the output of read csv to the second input of map


	Add an openalea.flow control.X node and connect its output the first input of extract


	Run the map object and display the result




[image: ../../_images/step5.2.PNG]

Note

The X object represents a function variable. The map apply a
function to each element received in its second input.





Plot 2D


	Add the nodes openalea.plottools.VS Plot and openalea.plottools.tuples2seq on the workspace


	Connect the map output the input of tuples2seq and the last output the VS Plot node.


	Run the dataflow


	Save it in the standbuilder package as plot_csv







Step 6 : Apply the process to multiple trees

In this step, we used the same method to build the entire stand


	Open the readcsv_3 dataflow


	Modify it in order to plot in 3D all the tree contained in the file and not only one


	Use a openalea.flow control.X node and a openalea.functional.map node


	Save this work in your standbuilder package as plot_stand




[image: ../../_images/step6.1.PNG]
[image: ../../_images/step6.2.PNG]




          

      

      

    

  

    
      
          
            
  
Using Visualea : Weberpenn

[image: ../../_images/intro1.gif]

Context

In OpenAlea [https://github.com/openalea], different tree architectures can be generated procedurally.
OpenAlea.WeberPenn is based on the tree generating algorithm defined by Weber and Penn in 1995.

The model generates a tree structure based on a set of allometric rules.
Fundamental parameters are, for instance, the overall appearance of the tree,
the size of the lower part of the tree without axes, the max branching order or the curvature of the axes.



Install

Install Visualea and Weberpenn for this tutorial

conda install -c openalea openalea.weberpenn openalea.visualea





Then, execute this

visualea







Model Parameters

Image Courtesy of Wolfram Diestel, developer of the Arbaro software [http://arbaro.sourceforge.net/].


	
General shape parameters :

Scale and ScaleV : Global size of the tree

BaseSize - Size of the lower part of the tree without branches



Each other parameters are defined for each branch level (or order) with order0 = trunk

[image: ../../_images/weber_param_1.png]


	Branch length is specified by the user at each order and
is relative to the father branch length and to the overall shape of the tree.

[image: ../../_images/weber_param_2.png]


	rotation (aka rotationV) define the phyllotaxis angle at each order

[image: ../../_images/weber_param_3.png]


	
curve parameter defines curvature of branches

curve back define inflexion angle



[image: ../../_images/weber_param_4.png]


	down_angle define the angle of insertion between a branch and its father

[image: ../../_images/weber_param_5.png]






Begin with weberpenn

Once you’ve launched Visualea, in the package manager, go in demo and double-click on demo_WeberPenn.

[image: ../../_images/package_manager.png]




There will see two workflows in the workspace.



[image: ../../_images/step1_1.PNG]

Workflow 1

On this workflow, there are the global parameters, trunk, order 1, order 2, tree parameters,
weber and penn and plot3D nodes. You can change some parameters by double-clicking on the nodes.


	Global parameters change main parameters of the tree like its shape

[image: ../../_images/step1_2.PNG]








	trunk, order 1 and order 2 allow to change parameters of the current order

[image: ../../_images/step1_3.PNG]








	tree parameters synthesizes all the parameters into a unique global parameters object


	weber and penn computes the scene with all the generated surfaces


	plot3D displays a 3D-scene




Right-click on the plot3D node and click on “Run”. The scene will appear and you’ll be able to see the
tree architecture corresponding to the inputs you’ve entered in the parameters nodes


Tip

You may want to change some parameters and see the impact on the tree architectures in real time.
To do this, right-click on the plot3D node and click on “Mark as User Application” then run the node.
Now, when you change a parameter, the scene updates instantly. Have fun !!!



[image: ../../_images/step1_4.gif]


Workflow 2

On this workflow, it is the same as the Workflow 1 but you only have to choose the species you want in the
species node. There are 3 species that have been preset.

[image: ../../_images/step1_5.gif]
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Contributing


Introduction

OpenAlea [https://github.com/openalea] is open-source. Everyone is welcome to contribute.


Note

All the packages are separated on two Github [https://github.com] pages


	the official and stable packages on OpenAlea [https://github.com/openalea]


	the unofficial, WIP and to be reviewed packages on OpenAlea-Incubator [https://github.com/openalea-incubator]






There are many ways to contribute to OpenAlea [https://github.com/openalea]. The most common ways of contributing are coding or documenting different parts of
the project. One may improve documentation which is as much important as improving the code itself.
One could also create their own package, see How to contribute.

Another way to contribute to the project is to report bugs ans issues you are facing.



How to contribute

The main way to contribute is to fork the package repository you are interested in on GitHub [https://github.com]


Note

Remember, the packages are found on different GitHub [https://github.com] pages. The following steps describe a tutorial for an OpenAlea [https://github.com/openalea] package.
Make the good changes if you want to use OpenAlea-Incubator [https://github.com/openalea-incubator] packages.




	Create an account [https://github.com/join] on GitHub if you do not already have one.
You will choose your GitHub [https://github.com] login <your_login>.


	Fork [https://help.github.com/en/articles/fork-a-repo] the package repository of your choice (for instance, MTG repository [https://github.com/openalea/mtg]) and click on
the ‘Fork [https://help.github.com/en/articles/fork-a-repo]’ button near the top of the page. It generates a copy of the repository under your
account on the GitHub [https://github.com] user account. For more details on how to fork a
repository see this guide [https://help.github.com/articles/fork-a-repo/].


	Clone [https://help.github.com/en/articles/cloning-a-repository] your fork of the package repo from your GitHub [https://github.com] account to your
local disk

git clone https://github.com/<your_login>/<package_name>.git
cd <package_name>







	Create a branch <branch_name> to hold your development changes

git checkout -b <branch_name>





and start making changes. Always use a feature branch. It’s good practice to
never work on the master branch!


Note

In the above setup, your origin remote repository points to
<your_login>/.git. If you wish to fetch/merge from the main
repository instead of your forked one, you will need to add another remote
to use instead of origin. It’s good practice to choose the name upstream for it, and the
command will be:

git remote add upstream https://github.com/openalea/<package_name>.git





If the package you chose come from OpenAlea-Incubator, the command will be:

git remote add upstream https://github.com/openalea_incubator/<package_name>.git





And in order to fetch the new remote and base your work on the latest changes
of it you can:

git fetch upstream
git checkout -b <your_name> upstream/master









	Develop the feature on your feature branch on your computer, using Git to do the
version control. When you’re done editing, add changed files using git add
and then git commit files:

git add <modified_files>
git commit -m "description of what you've done"





to record your changes in Git, then push the changes to your GitHub [https://github.com] account with:

git push -u origin <branch_name>







	Once you’ve finished, you can create a pull request on the corresponding GitHub [https://github.com].
Follow these [https://help.github.com/articles/creating-a-pull-request-from-a-fork]
instructions to create a pull request from your fork.






How to make a proper bug report



Documentation

You can also contribute to the documentation. If you find some parts that are not explained enough or uncleared, you can complete or
improve the documentation.

Once you have forked the package on your device, you have to install Sphinx [https://www.sphinx-doc.org/en/master/] to generate the HTML output

pip install sphinx





In each package repository, it must be a docs/ directory in which the reStructuredText documents are. You can modify or create these and generate the HTML output in the docs/ directory

make html






Note

If you are creating your own package, you can build the Sphinx [https://www.sphinx-doc.org/en/master/] environment directly in the docs/ directory

sphinx-quickstart







Once you are finished, you can add, commit and push what you have done on GitHub [https://github.com] and then create
a pull request (see How to contribute).

As we want all the documentation to look the same way, configure your Sphinx like us:


	The theme we are using is the Read the Docs Sphinx Theme [https://sphinx-rtd-theme.readthedocs.io/en/stable/].
The theme can be installed like this

pip install sphinx_rtd_theme





Once you’ve installed the theme, write in your conf.py file

html_theme = "sphinx_rtd_theme"





Then write in the same file

html_theme_options = {
         'logo_only': True
}







	Download the OpenAlea logo and put it your _static directory and then write in your conf.py file

html_static_path = ['_static']
html_logo = "_static/openalea_web.svg"







	Mention the main website “openalea.rtfd.io”







Moving from Python 2 to Python 3
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License


	The OpenAlea core is released under the Cecill-C license.


	The OpenAlea GUI, Visualea, is released under the Cecill-v2 license.





Note

Each external package can have its own license, please check it before using a package.



You can refer to the document Package License Guidelines [http://openalea.gforge.inria.fr/dokuwiki/doku.php?id=documentation:guidelines:license_guidelines]
for futher explanations.

Please, cite [http://openalea.gforge.inria.fr/dokuwiki/doku.php?id=documentation:documentation#publications]
the project if you use OpenAlea in your publications.
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Help

Need help ? Want to contact someone ? Contact prenon.nom@machin.fr.
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 [https://nbviewer.jupyter.org/github/openalea/openalea.rtfd.io/blob/master/example/plantgl_objects.ipynb]
3D Geometric Modelling and Visualisation
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3D Reconstruction of Plant Architecture
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L-Systems Simulation
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Reconstruction and Ecophysiology of Grapevine
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Light Interception
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Strawberry architectural analysis construction & vizualisation of 2D/3D architecture.






          

      

      

    

  
_images/caribu_crops.png





_images/eartrack.png





_images/hydroshoot_grapevine.png





_images/hydroshoot_grapevine1.png





_images/hydroshoot_grapevine2.png





nav.xhtml

    
      Table of Contents


      
        		
          OpenAlea Documentation
        


        		
          Quick Start
          
            		
              Installation
            


            		
              Tutorials and Gallery
            


            		
              Packages
            


            		
              Development
            


          


        


        		
          User Guide
          
            		
              Visual Programming
            


            		
              Python Scripting
              
                		
                  Using Python
                


                		
                  Importing OpenAlea Modules
                


              


            


          


        


        		
          Installation
          
            		
              Conda Installation
            


            		
              OpenAlea Installation
            


          


        


        		
          Application Domains
        


        		
          Tutorials
          
            		
              Using Visualea : Beginning
              
                		
                  The Goal
                


                		
                  Step 1 : Create Your Own Package
                


                		
                  Step 2 : Read CSV Data
                


                		
                  Step 3 : Create a simple 3D representation of one tree
                


                		
                  Step 4 : Create a Macro Node / Group Nodes
                


                		
                  Step 5 : Get the spatial distribution of the trees
                


                		
                  Step 6 : Apply the process to multiple trees
                


              


            


            		
              Using Visualea : Weberpenn
              
                		
                  Context
                


                		
                  Install
                


                		
                  Model Parameters
                


                		
                  Begin with weberpenn
                


              


            


          


        


        		
          Gallery
        


        		
          Packages
          
            		
              Modelling with OpenAlea
              
                		
                  MTG
                


                		
                  L-Py
                


                		
                  PlantGL
                


                		
                  OpenAlea Framework
                


                		
                  VisuAlea
                


              


            


            		
              Plant Models
              
                		
                  WeberPenn
                


              


            


            		
              Plant Biophysics
              
                		
                  Hydroshoot
                


              


            


            		
              Phenotyping
              
                		
                  Phenomenal
                


                		
                  EarTrack
                


                		
                  Strawberry
                


              


            


          


        


        		
          Development
          
            		
              Contributing
              
                		
                  Introduction
                


                		
                  How to contribute
                


                		
                  How to make a proper bug report
                


                		
                  Documentation
                


              


            


            		
              Moving from Python 2 to Python 3
            


          


        


        		
          License
        


        		
          Help
        


      


    
  

_images/lpy_lpymagic.png





_images/lpy_lpymagic1.png





_images/intro.gif
Croe o Qe

> B2 _mypacage_(1)
> B inea (1)
> BB demo(1)
> B openslea (19)
~ B3 sandouicer (9)
(63 potsana
(2 potstan
(5 read cv.oa
(5 rendes.1
[ rescen2
[ rescen 3
[T simpi.ree
7 veescene
@ scene png witer
> 3 sandbuider o (1)
> B ol (3)

oroce 1 -t st €3

 PlantGL 30 Viewer
Ele Eot View Toos Help

i T iy
il operetar (ouls-iap 31 & bls-in mole
<o “eperaar (e ia)s s 5 buie- by moile

Ceperes platel scengraoh peisg Trrsiated chfec ¢ OxsosomneLODroE>
Puarriagiosi i e g i rrhpdor

cpmalen\isanlen\gap. cparatar\_init_py", Mne 115, 1 wrappedtPioool






_images/intro1.gif
[Pupa—  PlaniL 30 Viewer
Fie Edt View Toots Help

£ B 6 ¢ ¢ e A0 ) oMK k8 B %o &

Comtrnes 8 x|

P 5

om0

§E 2






_images/mtg_plantframe2.png





_images/openalea_web.png
OpenA%





_images/mtg_plantframe.png





_images/mtg_plantframe1.png





_images/package_manager.png
@ Package  H Category R search

> B _my package_ (1)
> [0 alinea (1)
v [0 demo (1)

e

[ demo_Weberpenn
552/ demo_WeberPenn_grp_1
523 test_quakingaspen

> [ openalea (19)

> [ standbuilder (9)

> E standbuilder_tuto (1)

> [ vplants (3)






_images/phenomenal.png





_images/plantgl.png





_images/step1_4.gif
 PlanGL 30 Viewer = B 8
T Fie Edit View Toos Help

[esSpa— 5D |
i 8 e ¢ ¢ o 40 0 oMK X8 ¥ #- o>






_images/step1_5.gif
28000 volgomME klns 5. oo
T

m Pracdons o s & ook v

e o
[Cr— )
o

[IEC—

[0






_images/plantgl_objects.png





_images/step1.gif
» Visudlea
File Paciage Mansger DataPool Workspace Python Window Help

@rae  owgny Qsed  wemexo- O

> B3 _my package_ (1)
> @ slinea (1)
demo(1)

> 23 openalea (19)

> B3 stanabuider2 (9)
> B8 velans (3)






_images/step2.3.gif
¥ Visudles - o X
| ackge Manooer DotaPocl Worspace Puhon indow Help

NewEmoty Workspace  CateT

Openrecent 5

Save as Compasite Node.

wetspna0- @

>

0341t dtsner=3,crom_St20,crom 5 18,Y-0,10)
s






_images/strawberry.png





_images/step2.1.gif
& rev.ete. T lnea Cortuse oo
|8 rodopenseatin
& recioes openaatie)

(6 resc.1 Gtancge)

I resse 2 anabuic

L L ——————
& revd oo opensentiecs)
(Epry———

[ ress_cov data tancouicen)

F L p—

& poot reads apenaetowconio)
6 woraescr (penseaOaLao)

& 1o e (pensieasiatrie

& Wors sta cpensesOALa)

9 DotoPool  welp =

Ponshestoggng

Siyter ascomale 451
o 5 i o1 s, s 34 e 5 1 .50 4 i oS






_images/step2.2.gif
W Visudlea - o x
i PocageMonager Daabol Waspce Py Winow. Helo

@roe B Quwn a0

> B mypsasoe_(1)
> @ alinea (1)

> [ demo (1)

> B8 openalea (19)

> B3 standbuider (9)
B soncvuisersio

> 88 volants (3)

Ponshes oggng
upper Gecomete 450 B

Prhon 1713 [acond, Tnc| (default, tar 18 2wk, 18:63:27) (15 v.i588 6 bic (wOS8)]
e g ereies” o Ticeme’ for mre inforation.

i






_images/visualea_workflow.png





_images/weber_param_1.png





_images/strawberry1.png
